Tvorba vlastni vystrihovanky

Navod na tvorbu modeli z papiru

Petr Kaspar

Pti tvorbé vystiihovanek se budeme drzet
zavedenych zvyklosti, které pro Ceskou
republiku nastolil ptevazné ing. arch.
Richard Vyskovsky. Tento autor publi-
koval své papirové modely hlavné
v Casopise ABC a kazdy kdo se zajima
0 vystiithovanky se s jeho praci pravde-
podobn¢ setkal. Proto i my budeme
dodrzovat stejné znaceni a postupy.

Jedna se hlavné o znaleni ohybu,
¢islovani dilct a celkovou strukturu
navodu.

ing. arch. Richard Vyskovsky

Veskeré prace budeme provadét v programech, které jsou zdarma dostupné, nebo
ptistupné na Skolnich pocitacich.

Jedna se o programy:

Google SketchUp:

Download: http://sketchup.google.com/intl/en/download/

Google LayOut:

Program je soucésti Google SketchUp Pro a je v Casoveé omezené trial verzi zdarma.

A k Gplnému dokonceni pouzijeme program na tvorbu PDF souborti. J& pouzivam
program Scribus, ale vy muzete pouzit jakykoliv program, se kterym mate zkusenosti.

Tyto programy jsem volil pro jejich snadné ovladani, vhodnost k tvorbé jednoduchych
modeld (které pro papirové modely plné dostacuji, nebot’ drobnéjsi detaily papir
nesnese) a snadno se obohati o pluginy, které nam praci usnadni. Navic jsou s nimi
studenti seznameni v ramci kurzti CAD, nebude nés tedy zdrZzovat neznalost tvorby
3D modelu.

Vystiihovanky lze tvoftit také bez pouziti 3D modelu, stac¢i mit dostate¢n¢ podrobné
zobrazeni v MP: pohledy a fezy (stavebni vykresy jsou vlastné timto pozadovanym
zobrazenim).



http://sketchup.google.com/intl/en/download/

Celou tvorbou vam pifedvedu na mém modelu rozhledny Stépanka, ktera
je povazovana za nejhezc¢i rozhlednu Jizerskych hor. Na kazdou budovu je tieba zvolit
vlastni poStup, proto se navod neda psat obecné. Nejprve vysvétlim praci na svém
modelu a na zavér predvedu piiklad feseni béznych detailti, jako dvete, okna,
zakiivené plochy, kopule, vikyte, kominy a jehlanovité Spicky vézi. Cely navod
si nejprve prectéte a teprve poté zacnéte s praci na vlastnim modelu.

1. krok - Vybér stavby

Jako model je nejvhodngjsi zvolit stavbu, ke které mame moznost snadno sehnat pod-
klady. At uz vykresy na stavebnim ufad¢, nebo ru¢ni zaméteni. Proto volime bud’
znamé zahranicni ¢i Ceské stavby, nebo stavby, ke kterym mizeme zajit, nafotit je
a zm¢fit jejich rozmery.

Ja volil Stépanku proto, ze k ni mohu béhem jednoho dne dojit a je to jedna z ikon
Jizerskych hor.

Jak muZzete vidét z pfiloZzen¢ho obrazku, u starych staveb se nevyplati spoléhat na
udaje z podkladt dostupnych na stavebnim uradé, ¢asto jsou nekompletni, neodpovi-
daji realité, v pohrani¢i jsou dokonce némecky.

2. krok - 3D model

Nyni vytvotime 3D model v programu Google SketchUp. Nez
zatneme, musime si ujasnit v jakém méfitku bude
vystiihovanka provedena. Je to na vaSem osobnim rozhodnuti,
ale doporucuji volit nekteré ze standardnich méfitek a to
pokud mozno tak, aby vysledny model neptesdhl rozméry
30x30%30 cm. U staveb, jejichZ jeden rozmér je vyrazné vetsi
nez rozmery ostatni, Ize toto pravidlo pochopitelné porusit, ale
je nutno pamatovat na to, Ze velmi velké hotové vys-
tithovanky vétSinou neptsobi prili§ pékné. Ve ovsem zalezi
predev§im na konkrétni stavbé a navrhu modelu. Podle toho
ur¢ime miru detailt 3D modelu. Nejmensi mozné detaily na
papirovém modelu jsou 2 mm. Mensi dilky by uZ modelaii

nebyli schopni uspokojivé zvladnout (mé&jte na pamnéti, ze e ey

velké ¢ast modelari jsou déti).

e

Na internetu je mozné stdhnout mnoho hotovych 3D modelt staveb. Drazné vas vsak
pfed timto feSenim varuji. Modely nejsou tvofené s ohledem na néslednou tvorbu
papirové vystiithovanky a jejich upraveni je zpravidla pracnéjsi nez tvorba vlastniho
modelu.
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http://cs.wikipedia.org/wiki/Štěpánka_(rozhledna)

Pti tvorbé 3D modelu méme na paméti nékolik pravidel. Model budeme rozkladat do
roviny, proto modelujeme pouze to, co bude soucasti vysledného papirového modelu.
Vyvarujeme se tedy piesaht, prolinani jednotlivych ¢asti a dalSich postupti bézné
pouzivanych v 3DsMaxu a podobnych programech. Také viibec nepouzivame skryté
hrany, mohli bychom na né¢ zapomenout a vadily by nam jak pii texturovani, tak pfi
rozkladani modelu do roviny. Veskeré hrany nechte viditelné, po rozvinuti ptijdou bez
problému odstranit.

Je nutné si uvédomit, Ze nékteré tvary ani nejsme schopni z papiru vytvorit. Musime
proto uz pii tvorbé 3D modelu na podobné situace myslet a model podle nich zjedno-
dusit. SketchUp ma pro nés tu vyhodu, Ze veskerou geometrii sklad4 z ¢asti rovin,
dokonce i koule je jen vétsi mnozstvi rovinnych plosek.

Obrazek ilustruje tvorbu 3D modelu. Na prvnim obrazku je detail vstupu do rozhled-
ny, na druhém obrazku je ten samy detail zobrazeny zespoda zezadu. Cervené jsem
obtahnul chybu, malé plosky ptfesahujici za viditelny plast’ stavby. Na papirovém mo-
delu nebudou a jen by ndm komplikovaly rozvinuti modelu do roviny. Na podobné
véci pozor! Zelenou barvou jsem obtahl plochu, kterd bude tvoiena jednim dilem,
hrana vznikne pouze ohybem dilu, nikoliv slepenim dvou ¢asti. Piestoze to neni plo-
cha na plasti budovy, jeji odstranéni by modelafim velice znesnadnilo praci
a papirovy model by byl méné stabilni. Zlutou barvou je obtazen podpirny pilif, ktery
bude z né€kolika dili zkompletovan zvlast’ a poté bude nalepen na konstrukci rozhled-

Podobné musite uvazovat u vaseho modelu, neexiStuje ptesny navod na postup. Proto
je tato prace tak zajimava a tak t€zka. Velice vam vSak pomuze zkuSenost s lepenim
papirovych modelti. Doporucuji nékolik modelll sestavit piedtim, nez se pustite
do tvorby vlastniho.

Nyni je také spravny Cas na tvahu o tom, jak zpracovat terén, okoli modelu. Pokud
bude soucésti papirové vystiihovanky, vymodelujte ho spolecné s vlastni stavbou.
U nékterych staveb lze vynechat.

Pokud ma vas model velké prazdné prostory uvnitt, doporucuji vymodelovat podptr-
na zebra, které papirovou konstrukci ponesou, 1 kdyz se na jejim vnéj§im vzhledu ne-
budou podilet. To je velice casté pfi modelovani terénu. Viz obrazek zakladniho teré-
nu a pohled zespod na Zebro, které zamezi prohybani papiru:




3. krok — Textury

Vyjimecné lze mit model i bez textur, ale neni to bézné. Pokud mate moznost budovu
nafotit, je nejjednodussi pouzit fotografie a nanést je na model jako textury, coz ndm
SketchUp umozni opravdu snadno.

Vyberte zvoleny povrch modelu (1) a v okné Materials (Window => Materials) pte-
jdéte pod zalozku edit (2) a zaSkrtnéte volbu Use texture image (3):
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Textura je nyni na modelu, ale pravdépodobné¢ nebude zobrazena spravné.
To opravime nasledovné: Kliknéte pravym mysitkem na vybrany povrch, z vyvolané
nabidky zvolte Texture => Position a pohybem 4 pfipinacki na rozich textury ji za-
rovnejte:
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Pokud nemate moznost potidit fotografie stavby, mtizete pouZit textury, které obsahu-
je ptimo SketchUp, nebo nalézt vhodné textury na internetu.

Dalsi moznosti je namalovat dily ru¢n¢, vysledek bude pti peclivé praci Casto lepsi
nez fototextury. V piipad€ rucni kresby kapitolu 3 pieskocte a dily dokoncete az po
vytisknuti vystfihovanky.



4. krok - Rozvinuti modelu do plochy, tvorba dila

3D model méame hotovy, nyni ho rozvineme do roviny a vyrobime z néj jednotlivé
dilce vystfihovanky. Nejprve SketchUp rozsitime o plugin Unfold tool, ktery nam
praci vyrazné usnadni.

Stahnéte ho z adresy:

http://sketchup.wu.cz/data/pluginy/unfoldtool.zip, rozbalte a nakopirujte do adresaie
"plugins", implicitn¢ "c:/programfiles/google/sketchup/plugins" a restartujte program.
Nyni se vam pod zalozkou Tools zobrazi nastroj Unfold.

Pouziva se nasledovné: Po kliknuti na unfold vybereme plochu, kterd slouzi jako
zacatek rozkladani modelu do plochy. Poté klikneme na sousedni plochu a nastroj
unfold k ni zarovna ptedchozi vybeér.

Postup prace 1épe popiSe nasledujici obrazek: Z hotového modelu piekopirujte
vybranou ¢ast (1), v mém ptipadé stiechu rozhledny. Vybranou ¢ast rozd¢€lte prostym
vybérem a kopirovanim na casti podle dild (2). Nasledné dily rozlozte pomoci
nastroje Unfold (3). Rozlozeny dil otocte do vodorovné polohy (4). Piivodni model
zachovejte nedotceny, bude potieba k tvorbé ndvodného obrazku.

Vytvotené dily jeSté¢ musime opatfit chlopnémi, aby je bylo mozné slepit. To je
vhodné ud¢lat u kazdého dilce rovnou po rozlozeni, ja to vSak kvili prehlednosti
navodu popisuji v naledujici kapitole.


http://sketchup.wu.cz/data/pluginy/unfoldtool.zip

5. krok - Chlopné

Dily mame hotové, ale jesté je musime opatiit chlopnémi, aby je bylo mozné piilepit
k dal§im dilim. Kazda hrana dilu musi mit chlopefi, nebo musi byt chlopen na hrané
dilu ktery bude na dil navazovat. Sirka chlopni je volitelna, doporuduji vybrat
Ji z rozmezi 2—7 mm podle velikosti dilu ktery chlopné obsahuje. Mensi rozméry jsou
na hranici zvladnuti pro modelafe, vEétsi rozméry uz spiSe ohrozuji vzhled modelu,
nebot’ ¢im vice lepidla bude na chlopen pouzito, tim vyssi je riziko krabaténi papiru.
Chténou velikost na papife pfepocitame podle zvoleného métitka a vymodelujeme
ve SketchUpu. Také musime zkontrolovat je-li na chlopen misto na dilu kam budou
modelafi chlopné lepit. Ohyb ¢i otvor blizko kraje dilu mohou nalepeni chlopné
branit. Tomu se musime vzdy pfizptisobit a chlopenn podle toho upravit. I vlastni dil
mize po naohybani chlopné vadit. Uhel skoseni hran chlopni je b&Zné 45° nebo
mensi.

Pro lepsi pochopeni opét uvadim obrazky ilustrujici vySe popsané: VSechny dily stie-
chy jsou nyni v rovin¢ a opatfeny chlopnémi. V§imnéte si: Chlopeni u vrcholu jehlanu
je skosena pod thlem 18°, aby se vesla na plochu, kterd je ji umoZnéna ohybem dilu
(1). Malické chlopné spojujici hrany, které jsou na dilu blizko u sebe, nejsou vyne-
chany. Piestoze pijdou velice Spatné lepit, zakryji alesponn otvory do modelu
a s trochou lepidla budou dokonce funkéni (2). Otvor do spodniho dilu stiechy by
nebyl nutny, ale ponechana plocha je dostate¢na na nalepeni chlopni a pfistup prsti
k zadni stran¢ dili modelaitiim velice usnadni praci. Proto se o to snazte vzdy, kdyz je
to mozné a neohrozi to pevnost modelu (3).




I na ptfidavani chlopni existuji pluginy, zde vSak doporucuji rucni postup. Jesté jsem
nam dostatecné usnadni sdm SketchUp. Kopirovani, posun a rotace budou naSimi
hlavnimi nastroji. Od této chvile pfepneme pohled na TOP a v pracovnim prostoru se
budeme pohybovat pomoci Shift+mmb (middle mouse button, prostfedni tlac¢itko my-
§1), tim vlastné eliminujeme tieti rozmér, ktery by nam nyni pouze prekazel.

6. krok - OSeti‘eni hran chlopni, usnadnéni prace modelairim

Jak vidite na vySe uvedeném obrazku, kazda chlopeil ma na hrané¢ kterou pfiléha
k dilu prouzek barvy ktera nejvice odpovida texture dilu.

To se provede snadno:

Chlopen (1) rozdélte dalsi ¢arou (2), vzniklou plochu otexturujte zvolenou barvou (3)
a pridanou ¢aru skryjte pomoci volby Hide (4).

Pro urychleni pouzivejte kldvesové zkratky, zde: E (pro vybrani nastroje Erase)
a Shift + Imb (left mouse button, levé tla¢itko mysi) kliknéte na vybranou ¢aru. Pokud
jste omylem skryli néco jiného: View => hidden geometry => rmb na vybranou ¢aru
=> unhide.

Toto ptestava byt u vystfihovanek bézné, smysl to vSak ma. Nepiesnosti pii lepeni
jsou diky tomu daleko méné vidét a model vypadd skvéle i bez dodateéného
zabarvovani bilych mist nepfesnosti. A o to nam jde nejvice, nesnazime se o co nej-
méng¢ prace pii tvorbé modelu, ale o co nejhez¢i vysledny model.

7. krok - Usporadani dila k tisku
Nyni mame vSechny dily v jedné roviné. Pfipravime si obdélniky o velikosti papiru na
ktery budeme vystiithovanku tisknout. Tzn. rozméry papiru vynasobené meétitkem

modelu. Na takto pfipravené ,listy papiru® poskladame jednotlivé dily tak, aby
zabraly co nejméné lista.
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Pokud ma né&jaky dil ¢ast, kterd bude vystiizena, mizete klidn¢ dily umistit i do ni.
Bézné se to pouziva k uSetieni mista.

8. krok - Cislovani

Kazdému dilu ptifadime jeho ¢&islo, aby se na n&j dalo v navodu odkazovat. Cislujeme
presné tak, jak budou modelafi postupovat pii lepeni modelu. Musime si tedy v hlavé
rozvrhnout postup lepeni modelu a podle néj dily ocislovat. J& kupiikladu za¢indm
sttechou a Cislovani postupuje, stejné jako prace na modelu, odshora dolti. Nejprve
stiecha, poté cihlova ¢ast rozhledny a nakonec kamenna c¢ast s pilifi. To je vhodné
1 proto, ze zatimco lepidlo na jedné cati modelu schne, mize modelai pracovat na
dalsi ¢asti. I to by mélo byt vzato v potaz.




9. krok - Pomocné znaceni

Abychom uleh¢ili praci modelaiim, pouzivame jesté nckolik znacek, které jim pii
praci na modelu napovi jak jednotlivé dily slozit. Na kazdou chlopenn uvedeme ¢islo
dilu, na ktery bude nalepena. Pokud je chlopen ur¢ena k nalepeni na ,,vlastni dil (tj.
na stejny dil, na kterém je umisténa), uvadi se znacka ,,%".

Dalsi znacky slouzi k tomu, aby modelafi poznali jestli je ohyb dilu konvexni, nebo
konkavni. Konvexni ohyb se oznauje kulickou, konkavni trojuhelnickem. Od znacek
se vede linie ke hran¢ ohybu.

Jako posledni znacka se pouziva ikonka nlzek, k oznafeni mista které ma byt
rozstfihlé 1 kdyz na dilu neni dost mista k vynechani prostoru. Nazorngjsi bude opét
obrazek ilustrujici popsané znacky:

o Konvexné

»— Konkavné

Cisla na chlopnich uréité smysl maji, znak niizek také, ale naznadeni sméru ohybu lze
dle mého nazoru vynechat. Dily se stejné ohybaji aZ po vystiiZeni a tim znafeni ztraci
smysl. Snad nikdy jsem jesté nebyl nucen dohledavat odstiihlé ¢asti jen kviili zjisténi
sméru ohybu. Dle mého je to zbyte¢na véc, kterou uvadim jen pro komplexnost.
U komplikovanych dilt bych dal pfednost upozornéni v navodu a u lehkych dila
znaCeni neni nutné a jen znepiehledfiuje vystithovanku. Konecné rozhodnuti
je samoziejme na vas.




10. krok - Priprava na tisk, tisk do PDF

Vystiihovanka je prakticky hotova. Staci ji pouze vytisknout. To provedeme pomoci
programu Google LayOut. Ve SketchUpu odstrafite pomocné rdmecky ohranicujici
listy papiru. Néasledujici postup 1épe pochopite diky pfilozenym obrazkiim. Oteviete
program LayOut, a nastavte format papiru, ja pouzivam A3 které nasledné ohnu
napul. Hotova vystfihovanka tak bude na formatu A4. Ptipadné 1ze pouZit pro vystup
pfimo format A3.
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Modfe ohraniceny obdélnik roztahnéte za hranice papiru.

lamevorsommem,

V pravém menu sjed'te k zalozce SketchUp model. V ni kliknte na tladitko Ortho,
nastavte pohled na Top a vyberte vase métitko. V pravém dolnim rohu mate na vybér
ze tf1 moznosti tisku: Vector vyberte pokud nemate na dilech textury, druha moznost
neni pro nas a Hybrid zvolte v pfipadé otexturovanych dili. Modry obdélnik, ktery
jsme v minulém kroku rozsitili az za hranice papiru slouzi jako "okno" do vaseho
modelu ve SketchUpu. Nyni uz skrz okno vidite ¢ast modelu ve zvoleném méfitku.
Kliknéte do prostoru modrého okna a pomoci Shift + Lmb presuiite model tak, aby
byla v okné ¢ast, ktera patii na tuto stranku.




Export je v nabidce File => Export => PDF. Ve vyvolané nabidce zvolte nejvyssi
kvalitu a potvrd'te.
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Dalsi stranku vytvofite pomoci ikonky s listem a znaCkou + v horni listé. Postup
opakujte dokud nevytisknete vSechny stranky vystfihovanky.

11. krok - Navod, navodovy obrazek

Zbyva napsat navod, aby modelati védéli jak postupovat pii lepeni modelu. Navod se
zpravidla dopliiuje o nadvodovy obrazek, ze kterého je zfejmé umisténi jednotlivych
dild.

Nejprve je dobré uvést par slov tivodem, napsat néco o stavbé, kterou model
predstavuje.

Dalsi ¢asti jsou piipravné prace. Na ukdzku uvedu text, ktery uvadim ja ve své
vystiihovance:

K lepeni si pripravte nizky, nizticky, krabicku na dily, aby se vam neztratily
V pribéhu prace, pravitko, niz a lepidlo. Doporucuji lepidlo Herkules - schne rychle,
takze se pri kompletaci nemusi dlouho cekat, presto je chvili po prilepeni spoj jeste
mozné upravit.

Béhem prace udrzujte vie cisté, ruce zamazané od lepidla Spini dily modelu a kazi
vysledny dojem.

Pri stavbé postupujte podle navodu a béhem stavby se orientujte podle navodové
kresby. Prostor na dilu, ktery je treba vystrihnout je oznacen uhlopricnym kiizem.
Hrany, které budete ohybat, doporucuji nariznout lehce podle pravitka nozem. Kazdy
dil si nejprve slozte nasucho - lépe si uvedomite, jestli jsou hrany ohnuté na spravnou
stranu. Pokud je vse v poradku, chlopen jemné potiete lepidlem a prilepte.

Na chlopni je oznaceni na jaky dil ma byt prilepena (1 znaci, Ze chlopein ma byt prile-
pena na dil 1). Je-li chlopen lepena na ,,vlastni* dil, je oznacena %. (Mensi chlopné
muzou byt bez oznaceni, proto plati pravidlo dvakrat mer, jednou rez.)

Néleduje vlastni navod. PopisSte postup praci, upozornéte na obtizné Casti a podobné.
Opct ukazka:

Zacneéte stirechou. Skompletujte dily 1 a 2 a slepte je k sobé. Strechu dokoncete prile-
penim dilu 3.



Nasledovat bude vyhlidkova plosina. Skompletujte osm dilii oken 5 a viepte do dilu 4.
Teprve potom dil 4 uzavrete. Nasledovat bude mladsi cast rozhledny. Slepte Fimsu 6,
do dilu 7 vlepte ctyri okna 8 a dvé okna 9. Skompletovany dil 7 prilepte k rimse 6.
K dilu 10 prilepte dil 11 a skompletované dvere 12. Slepenim dilu 7 a 10 dokoncete
spojeni veze. Dil 4 napojte na rimsu 6. Ke strese prilepte horni vyhlidkovou plosinu,
tj. k dilu 3 prilepte dil 4.

Déle pak miizete uvést zavérecné poznamky k celému modelu, ptipadné vzkaz
budoucim modelaitim.

Navod doplitte navodnou kresbou. Ve SketchUpu nastavte pohled na vas neotexturo-
vany model, zvolte zobrazeni dvoj- ¢i tfiubéznikové perspektivy a nastavte Face style
na Shaded. (Pokud tuto nabidku nemiiZete najit: horni liSta zalozka View => Toolbars
=> Face style.) Z vyvolaného panelu zvolte Shaded. Exportujte pohled jako obrazek
ve vami zvoleném formatu a v libovolném obrazkovém editoru doplitte ¢isla dila.
Pokud vas pohled nepokryva model dostate¢né€, poskytnéte jich modelarim nékolik,
S ozna¢enim drobnych dila.

Pokud je vas model rozsahly, Ize jej barevné rozlisit, ¢isla dilti ¢asti modelu podbarveé-
te riznymi barvami a stejnymi barvami rozliste tyto ¢asti i v ndvodovém obréazku.




12. krok - Dokonéeni vystfihovanky, tisk

Zbyva vytvorit uvodni stranku, vystfihovanku vytisknout a svazat do vysledného
formatu. Na titulni strance je zvykem uvadét ndzev stavby, autora vystiihovanky,
méfitko a obtiznost modelu. Obtiznost 1 patii t€ém nejjednodussim miniboxim
(modylky domeckl a pod., v podstaté¢ jen kvadry se stfechou), obtiznost 5 patii
komplexnim a velice naroénym modeltim.

Strany na kterych jsou dily tisknéte na matny papir vyssi gramaze (nejlepsi je témet
nesehnatelny 100g, nebo dostupnéjsi 120g) samoziejmé jen z jedné strany (Casto
je na rubu dili uveden navod, nechapu pro¢ je tento nesmysl stale popularni).

Petr Kaspar
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Tim je tento navod kompletni. Na zavér uvedu piiklady typickych feSeni nckterych
architektonickych detailt.



Valec jako télo véze atp.

Jednoduchy tvar. V ndvodu uved'te radu at’ modelaii pfed sestavenim dilu ohnou dil
pomoci tazeni pfes hranu stolu. Trojuhelnikové chlopné, které se pouzivaji pro
zaktivené plochy, se vzdy ptfidavaji na dil plasté, ne na podstavy. Kruh by po ohnuti
chlopni vpadal neforemné, zatimco na plasti se chlopné tolik neprojevi. Pro rozvinuti
plasté do roviny pouzijte opét plugin Unfold (pokud mate na plasti texturu), nebo
vytvoite obdélnik se stranou dopocitanou podle obvodu podstav. Nastavite-li valci
vice segmentid, nebude nepiesnost (valec x n-stén) vibec znatelnd. Podstavy tvori
samostatné dily.

Kuzel jako stiecha véZe atp.
Pokny jsou prakticky stejné jako pro valec. Na chlopen u vrcholu pouzijte mensi thel.




Zakrivené roviny jako zdi baroknich staveb atp.

Pokyny jsou prakticky stejné jako pro valec. V navodu upozornéte na obtizny dil
a porad’te vyzkouseni nasucho. Zmény sméru ohybu naznacte nepatrné na dil, nebo
pokud to nenapadné nejde, v nédvodu porad’te modelaifim propichnout v onéch
mistech na krajich dil kruzitkem a z rubové strany narysovat linku tuzkou.

Polokoule jako kupole atp.

Ptedné si musime ujasnit, Ze polokouli z papiru vyrobit nelze. Musime se tedy tomuto
tvaru co nejvice priblizit za vyuziti papiru. V ilustratnim obrazku je zapnuto
zobrazeni skrytych Car (Carkovang).
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Komin

Chlopné na spodni stran¢ dilu se ohybaji na opacnou stranu a cely dil se vlepi do
otvoru v dilu stfechy. Vrchni ¢ast kominu je tvofena pouze slepenim piekryvu dvou
¢tvereckl o Sifce komina, nepouziva se zde chlopni. Na komin se zpravidla lepi jesté
dalsi dil, ktery je tvofeny pouze dvéma Ctverci, které se prehnou a ptilepi k sobé. Tyto
dva ¢tverce jsou o malo vétsi nez primeér komina.




Viky¥
Nejprve zkompletujte oba dily, poté je vlepte do otvoru v dile stfechy.

AR

Elektronicka verze tohoto ndvodu je pfistupnd na strankach pfedmétu Deskriptivni
geometrie ve formatu PDF. K névodu je pfilozena i vystfihovanka rozhledny
Stepanka, kterou vam doporucuji projit a zejména si povsimnout n&kterych feseni:
Zabradli na spodnim ochozu (dily 13a a 13b), feSeni vstupnich dvefi do mladsi,
cihlové ¢asti rozhledny a ozdobné fimsy na kamenné ¢ati rozhledny (dily 19).

Hodné zdaru pri tvorbé vasi vlastni vystfihovanky!!



